                                                                       
                                                                                       Mekong (CMS)

1. Login
Showing session expired when clicking on the logo.

[image: ]

2. Improve the design of the login page.
3. Username should be in a word.

[image: ]



4. Invalid and blank captcha
Add a cross icon.

[image: ]

5. All fields are required. Field spelling is wrong. Please check.

[image: ]


6. Add a hint for both fields like forgot password. (Username and password)

[image: ]

7. Forgot the spelling is wrong in website url.
8. The Mekong logo is missing.


[image: ]


9. Logout button should be aligned.

[image: ]

10. Dashboard > List
Report and Publication replaced by Report & Publication.

[image: ]



11. Title's name of News, Priority area.. should be similar.

[image: ]
12. Search filter
It should be similar everywhere like Search Title.

[image: ]
13. Dashboard > Filter
It should be a Select Priority Area.

[image: ]

14. Cards
It should be the same as singular and plural.

[image: ]


15. Country Wise Project Details
Add "s" at the end of the project.

[image: ]

16. List > News
Change the title of this and S. No. should be in one line.

[image: ]



17. Add news
Add title should be a case like title or running and Related news field should be aligned.

[image: ]


18. Body Description - Validation is missing.

[image: ]


19. All messages should be in title case.

[image: ]

20. Picture is blurred when the user opens a new tab.

[image: ]




21. Change status
Do you want to Publish or Reject the News? -It should be this news.

[image: ]

22. 
























































23. Login
The wrong mail ID's message should be changed.
[image: ]

24. Forgot password
The submit button is not working. 

[image: ]



25. Home > Dashboard
The card count should be changed after applying the filter.

[image: ]

26. List > News
Status's button should be center-aligned.

[image: ]


27. News>Action
Edit icon> hint is showing view, it should be Edit.

[image: ]

28. News>Action
Delete button is not working.
[image: ]
29. News> pagination
The next button's hint is not showing.

[image: ]

30. The logout button should be aligned.



31. The cross button should be fixed.

[image: ]

29th Jan (Shivani)

1. Login Page - 
1.1. Wrong Validation - When the user clicks twice on the submit button, showing wrong validation for other fields.[image: ]

1.2. After canceling the recaptcha validation popup, all fields should not be blank.[image: ]


2. Session Expired screen - Please remove the extra dots.[image: ]












3. Dashboard -
3.1. Project - Project count is not correct for a few locations.[image: ]
3.2. Project - All country project count is not matching with the graph.[image: ]

3.3. Country wise Project Details - Please keep all changes as shown below - [image: ]


4. Common Issue - Please remove the dot, it should be “S No.” Keep symmetry in all the tables[image: ]


5. Common issue - Breadcrumbs are missing - The breadcrumbs should be available on all pages to allow for easy navigation.

















6. List > News
6.1.  Publish Date - Please add the hint text for the Date text box, not sure what date it is? Is this “Publish Date”?[image: ]


6.2. Please add the “Publish date” column in the list, it will be easy to search the date.[image: ]
















6.3. Add/ Edit News -  If user enter white space value in the then the mandatory field validation is not working, please correct this, white space shouldn’t consider as text[image: ]


6.4. Add/ Edit News - Please allow only image type of file in the image upload, restrict the other type of files like CSV, PDF etc
[image: ]




6.5. Publish Date - Does this functionality make sense to allow users to add long-gone and long-past dates?[image: ]


6.6. Body Description - Add> Edit - Validation missing for this field.[image: ]


6.7. Body Description - Image is missing in the body description.[image: ]


6.8. Body Description - Edit News - showing code for a second in the description when the user opens the edit page.
[image: ]

6.9. Related News - Add/ Edit - Validation missing for “Related News”.[image: ]


6.10. Related News - When the user cancels all field news and submits the form, the view shows all previous news.
6.11. [image: ]
6.12. Success message - It should be “Approved successfully”.[image: ]

6.13. Pagination - Paging issue - If the user is on page ‘2’ and changes the show entry to ‘50’ then it’s failing and showing an empty list. Please check this on all the paging screens.[image: ] 










1. List > Impact story > Search filter
Change the priority area dropdown like the Mekong website.

[image: ]

2. Search and Reset buttons should be aligned.

[image: ]

3. Add Impact story
Title and "story" are missing.
[image: ]

4. Users can select the multiple images in the impact story. Please check.

[image: ]


5. Some description is missing in the view page. Please check.

[image: ]


6. Published date is missing in the edit page.

[image: ]





7. Showing something went wrong when the user selects the date.

[image: ]


8. Publish date is wrong on the mekong website.

[image: ]

9. List > Report & Publication > Search filter
Status filter is not working. Please check.

[image: ]

10.  Getting an error "Something went wrong" when the user adds data.

[image: ]

11.  Project name is not visible in the edit page.

[image: ]

12.  List > Announcement > Add Announcement
 Event end date field should be mandatory or not. Please check.

[image: ]

13.  It should be Participates

[image: ]

14.  View Announcement
The Publish Date is wrong in the view Announcement.

[image: ]

15. Submit replaced by Update button.

[image: ]

16.  List > Priority Area
 Add a publish or reject button.

[image: ]

17.  List > Multimedia List
 Tttle name is missing and images are wrong.

[image: ]

18.  Validation message should be visible for the mandatory field.

[image: ]

19.  View Project
 Images should be aligned. Priority area and duration details are wrong.

[image: ]

20.  Edit project
 From and To date fields should not be visible when the project status is not   started.

[image: ]
21.  Project Implementation Agency detail is blank.

[image: ]

22.  



















1. Dashboard> "W" should be capitalized in "wise"
[image: ]
2. My Profile>In edit form, the heading should be "Edit Profile".
[image: ]

3. My Profile> edit> Space should not be considered as text.
[image: ]
4. My Profile> "Vietnam" country is added while adding PIA, and when the user edits the profile removes that country, and after updating that country is showing in detail.
[image: ]
5. The cross button should be fixed.
[image: ]
6. My profile>Allow only the image type of file in the image upload, restrict the other type of files like CSV, PDF, etc.
[image: ]
7. Change password>Eye button should be aligned to confirm password box.
[image: ]
8. Remove the priority area card.
[image: ]






Added multiple images but it is not showing in the view page.

[image: ]







30 Jan (Shivani)


1. List>  Title Name - Title name is wrong for all, please fix this.[image: ]
2. Common Issue - Add some gap in between all “Priority Area(s)”. Correct this on all screens.[image: ]


3. Common issue - Published Date or Publish Date - In few places, we can see Published Date and in few Publish Date, please keep symmetry[image: ]
4. Common issue - Impact Story & Multimedia - When the user scrolls down the page, a white screen appears.[image: ]


[bookmark: _ofkrdrza80lb]Report & Publication List
[bookmark: _xbxqlvffuy81]Add Report & Publication
[bookmark: _dfnyaf6v6u3q]


'Lato', sans-serif
[bookmark: _4zja17bduxuz]Update Report & Publication

-apple-system,BlinkMacSystemFont,"Segoe UI",Roboto,"Helvetica Neue",Arial,"Noto Sans",sans-serif,"Apple Color Emoji","Segoe UI Emoji","Segoe UI Symbol","Noto Color Emoji"



5. List> News - Observation - Keyword(s) & Priority Aria is missing in the view.[image: ]




























6. List> Impact Story - 


6.1. Search filter - Font size should be the same like others.[image: ]


6.2. It should be “Image” like other pages, keep symmetry on all screens otherwise change “Image” to “thumbnail Image” on all pages.[image: ]

6.3. Delete Success message  - It should be “Impact Story”.[image: ]













6.4.  View - Published Date is missing in the Impact Story “View”.
[image: ]




























7. List> Report & Publication - 
7.1. View - The user entered a different date in the form, but the view shows the wrong published date.[image: ]


7.2. Edit screen - Validation is missing for “Project “ field. if it isn't mandatory, please remove * on this.[image: ]


7.3. View - Observation -  “Project” field is missing in Report & Publication “View”.[image: ]










8. List> Announcement - 
8.1. View - It should be “Body Description”, Please correct this.[image: ]

8.2. Add/ Edit form -Validation missing for “Body Description”.[image: ]


8.3. View - Is this Address or Location, please keep symmetry on all pages.[image: ]


8.4. Is this a participant, a participate, or a participates? Please correct this on all pages.[image: ]


8.5. View - Observation - “Event, Start Date & End date” all fields are missing in the view.[image: ]

9. List> Priority Area - 
9.1. Edit Profile - “Submit button” Change this to the Update button.[image: ]




10. List> Multimedia - 
10.1. Delete - Delete functionality is not working.[image: ]


10.2. Add/Edit - Please add validation to the "Upload Image", if it isn't mandatory, please remove * on this.[image: ]
10.3. Success message - Please complete the sentence for both.[image: ]

10.4. Upload Image - Observation - When a user adds multiple images in add form, but the view doesn't display them all, is this the right functionality or not?





31 Jan (Divya)
1. Status and action buttons should be center-aligned.

[image: ]


2. Search and reset buttons should be aligned to the filter box.
[image: ]
3. If projects are not more than 10 then remove pagination.
[image: ]
4. From the dropdown list "select” option should not be selected as an option.

[image: ]

5. While scrolling, the dropdown list overlaps with the header.

[image: ]

6. In total beneficiaries field should not allow negative value.

[image: ]

7. To date should always be the date after the from date.
[image: ]

8. Allow only the image type of file in the image upload, restrict the other type of files like CSV, PDF, etc
[image: ]

9. Remove placeholder from everywhere.
[image: ]
10. Body description> in style more option is not working.
[image: ]
11. Edit Community Voices>Validation is missing the story field.

[image: ]



12. Thumbnail images - Remove the s at the last.

[image: ]





31st Jan (Shivani)

1. List> Multimedia - 
1.1. Delete - It’s not Impact, please correct this.[image: ]


1.2. Edit screen -  Please replace the submit button with an update button.[image: ]











1.3.  Edit screen - Upload Image - The “upload image” functionality is not working, if we cancel the single image, the upload image field does not appear. However, if we open the edit screen again, we can see the upload image field with an image.[image: ]


1.4. Edit screen - Displaying a warning for a few seconds when the user updates the form[image: ]
1.5. View - the entire screen is white, no data can be seen.[image: ]


2. Common issue - It should be “Publish”, it’s a common issue, so please change this on all pages.
[image: ]












3. Project - 
3.1. View> Duration - From Date & To Date - Wrong date displayed if Project Status is selected as “Not Started ”.
[image: ]


3.2. Edit - “Update” functionality is not working, please check this.[image: ]


4. PIA - 
4.1. View - Alignment issue - Please correct this.[image: ]







4.2. Mobile Number - Please add the validation for the incorrect mobile number.

.[image: ]


4.3. Edit - Please replace the submit button with an update button.[image: ]

5. Community voices - 
5.1. View - Please remove the extra gap.[image: ]
5.2. View - User selects the Profession as “IT specialist” but showing another name.[image: ]

5.3. Search Filter - Please fix this, the user can’t search this profession, please check for others.[image: ]


5.4. Edit> Thumbnail image - In the edit screen, showing validation for the image but users already fill this field in the add form.[image: ]


Grammer mistake, please correct this. Grammer mistake, please correct this.
11st Feb
1. impact>add>Description- space validation should be fixed.
[image: ]











                                                                                 PIA Module

1. Common issue
Login - Change the messages.

[image: ]

2. Forgot password is not working.

[image: ]

3. Logged pages should not be opened in the new tab.

[image: ]

4. Profile > View/ Edit
Email, Phone, Agency should be changed. It should be Email ID, Mobile No. and Agency/ Company Name.

[image: ]

5. PIA should not login his profile without approval by admin.


[image: ]
6. Home > Add Project
Priority area dropdown should be the same.

[image: ]

7. Showing a wrong date when the project status is "Not started".

[image: ]



8. Project
The update functionality is not working.

[image: ]

9. Page is redirecting on the same page after the click on submit when the some fields are blank.

[image: ]

10. Add Project functionality is not working when the user selects the two outputs and activities.

[image: ]




11. It should not be submitted blank.
[image: ]
12. When the user clicks the submit button, the plus icon gets out of the box.
[image: ]













1st Feb (Shivani)

1. Community voices - 
1.1. Mekong Website> Share your Story - Captcha validation is missing.[image: ]


1.2. Observation - The data does not get deleted from the mekong website after a user deletes it from the CMS.


2. Mekong Website> Project - When the user filters the data, causing the page to move upwards.[image: ]

1. Multimedia> list> Images overlaps with the next media image.
[image: ]
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